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Java Modules and New Features Introduction

Course Agenda

o Preface: Java State of the Union
+ Sessijon 1: Introduction to Modules
+ Session2: Working with Modules
¢ Session 3./ Type Inference

# Session 4:.<JShell

¢ Session'd: HTTP Client

# Session 6: Other New Features

o Session 7: Custom Runtime Images

Introduction 2

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 2



Java Modules and New Features Introduction

Typographic Conventions

+ Code in the text uses a fixed-width font
Catalog catalog = new CatalogImpl()
+ Code fragments are the same, e.g., catalog.findById(4)
¢ We bold/color text for emphasis
¢ New terms are often introduced in bold italics
~Filenamesand paths are also in italics, e.g., Catalog.java
+ Notes are indicated with a superscript number () or a star *
¢ Longer code examples appear in a separate code box (below)

package com.javatunes.catalog;

public class CatalogImpl implements Catalog {
public MusicItem findById(long id) {

}
}

Introduction 3

Notes:

(™ If we had additional information about a particular item'in the slide, it would appear here in the
notes, with the appropriate superscript.

+ We might also include related information that pertains more generally to the'slide.

Copyright © LearningPatterns Inc. All rights reserved. 3



Java Modules and New Features Introduction

¢ The course has numerous hands-on lab exercises
— Many use types from a fictional case study called JavaTunes
 /An online music store
— The lab instructions are separate from the main manual

o Setup files are provided with skeleton code for the labs
—-Students.add code focused on the topic at hand

— There.is a solution zip with completed lab code

+ Lab slides have an-icon in the upper right corner of the slide

— The end of alab is marked with.a stop sign

Introduction 4

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 4



Java Modules and New Features Preface: Java State of the Union
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Preface: Java State of the Union

Brief overview of broader changes and issues
in the post-Java 8 world

It-is-a non-goal of this section to list every detail,
nor to-identify which release each item applies to

Preface: Java State of the Union 5

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 5



Java Modules and New Features Preface: Java State of the Union

New Java Release Cycle

+ New "major" version every 6 months — March and September
— Started with JDK 9 in Sep 2017
— Two kinds of releases, detailed below

o Feature Release
= Implementation enhancements, possible new language features
—Not intended for long-term use
— Superseded after 6 months, with release of next version

¢ Long-Term-Support (LTS) Release
— This is what you're accustomed.to working with

— Plan is to mark a release.as LTS every 3 years

¢ Details in Oracle Java SE Support Roadmap [see notes]

Preface: Java State of the Union 6

Notes:

¢ From the Oracle Java SE Support Roadmap at
http.://oracle.com/technetwork/java/java-se-support-roadmap.htmi.

— For product releases after Java SE 8, Oracle will designate a release, every three years,as a Long-Term-
Support (LTS) release. Java SE 11 is an LTS release. For the purposes of Oracle Premier Support,
non-LTS releases are considered a cumulative set of implementation-enhancements of the most recent
LTS release. Once a new feature release is made available, any previous non-LTS release will be
considered superseded. For example, Java SE 9 was a non-LTS release-and immediately. superseded
by Java SE 10 (also non-LTS), Java SE 10 in turn is immediately superseded,by Java SE 11.

+ This is a very important document, packed with detail (and myriad footnotes).~If you are
responsible for maintenance and updates at your organization, you really need to read it in its
entirety.

Copyright © LearningPatterns Inc. All rights reserved. 6



Java Modules and New Features Preface: Java State of the Union

Versions and Support - Illustrated

o Except for LTS releases, these are really just 6-month
"technology previews"

— Official term is "feature release"

¢ You can see that LTS releases span several feature releases

Java 15
Java14 -
' Java13
Java 12
: . :
- M commercial support
Java9
» . .
Java 8 ,O )R ‘ camlciw,pporl‘
Preface: Java State of the Union 7

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 7



Java Modules and New Features Preface: Java State of the Union

JDK Update Schedule — By Example

¢ Non-LTS and LTS releases are more frequent now

— 9.0 Sep 2017 March and September each year
9.0.1 Oct 2017 one month later, coincides with below
9.0.2 Jan 2018 Jan-Apr-Jul-Oct update schedule J

-10.0 Mar 2018 JDK 9 is dead
10.0.1 ~ Apr2018
10.0.2 © Jul 2018

—11.0- LTS Sep/2018 next LTS in 3 years, JDK 10 is dead
11.0.1 7 Oct 2018

11.0.2 Jan 2019 —-12.0 Mar 2019

1103  Apr2019 | _
11.04  Jul 2019 g Sep 2019

11.0.5 Oct 2019
etc., until next LTS —17.0LTS ', Sept. 2021

Preface: Java State of the Union 8

Notes:

+ Look it over closely — see how it works?

+ This release schedule offers some nice benefits, in that updates are more frequent, and
predictable. (Though the versioning and non-LTS vs. LTS releases will take some getting used to.)

+ As a consequence, with more frequent releases, it can be more difficult'to quickly find the
applicable documentation for a specific release. Of course you can "google’it," but there isia better
way, built in to any JDK 11+ distribution:

— Release Notes and other docs for all releases can be found by simply starting at your JDK
installation, and opening <jdk-install>/’README.html, then click and browse from. there.

* Goes all the way back to JDK 6!
» Can be hard to find on some installations (e.g. Mac)

— Can also go to https://java.com/licensereadme, which forwards to an oracle page with links to
all Java installations going back to JDK 6.

— Oracle page is https://www.oracle.com/technetwork/java/javase/terms/readme/index.html

Copyright © LearningPatterns Inc. All rights reserved. 8



Java Modules and New Features Preface: Java State of the Union

Java Modules and JDK Version Numbers

¢ \We divide the world into two: pre- and post-modules
— Java 8 and earlier is pre-modules
—Java 9 and later is post-modules

¢ Java 11.is the current LTS release post-Java 8
= It's the baseversion and main focus of this course ()
—'Many post-11 releases - we cover some "goodies" from them

o For simplicity in the'course, we'll use terms like "Java 8 code”
and "Java 9 code, " efc.
—"Java 8 code" = any code pre-modules, on the classpath
» For example, your existing production systems
—"Java 9 code" = any-code organized into a module
 Also called modular code, deployed in a modular JAR file

Preface: Java State of the Union 9

Notes:
() You should not be using Java 9, 10, 12, 13, or any non-LTS release in‘production.
— These are all short-term "technology preview" or "feature" releases.

— Support for this type of release ends 6 months after the-release date; coinciding with the
release of the next version. If used in production, that would mean you lose support after 6
months. Not a good idea!

— This is why we use Java 11 as the main focus of the course. We do, however, show some
features from later versions so you know what will be coming in Java 17.(when it does arrive).
None of them are compelling enough (so far) to use a non-LTS release in.production.

+ "Java 8 code" includes all code written and compiled with any JDK earlier than'9.

Copyright © LearningPatterns Inc. All rights reserved. 9



Java Modules and New Features Preface: Java State of the Union

¢ Java Modules! JPMS = Java Platform Module System
— All code now resides in a module (of some type)
* Including all your Java 8 code written years ago — hmm....
— We now have modulepath in addition to the classpath
— New JDK command-line tools, enhancements to existing ones

+ JShell — REPL shell (Read-Eval-Print Loop) for quick-coding
— And running scripts

¢ New HTTP-Client
— Replaces outdated HttpURLConnection

¢ Reactive Streams
— Non-blocking publish-subscribe style stream processing

Preface: Java State of the Union 10

Notes:

¢ The Java Platform Module System (JPMS), initially called Project Jigsaw, appeared in Java 9.

— Itis by far the Number One Most Important New Feature, and a complete game-changer, with
the potential to affect nearly every aspect of Java development and.runtime execution — or not...

— As we'll see, even if you "opt out" of creating your own modules, you absolutely still need to
know how Java Modules works, as well as understand the other major changes that have taken
place in the Java 9 platform.

¢ As we'll soon learn, the Java runtime now treats all code as "in-a-module," including Java 8 code
written long ago.

— This is done via automatic modules and the unnamed module, which exist primarily for
migration purposes.

— Over time, the use of these two types of modules should decrease, as existing code (and
libraries) gets "modularized" into true named application modules, and new code is written in
modules from the beginning. Details forthcoming!

Copyright © LearningPatterns Inc. All rights reserved. 10



Java Modules and New Features Preface: Java State of the Union

+ Other enhancements
— Collection factory methods  [List-of("1ist", "of", "strings")
— Multi-release JARs (MR-JARS)
— Typeinferencing — Java has a var now
— Miscellaneous capabilities
* Process API updates, new Stack-Walking API
+ Java12+: Switch Expressions, Compact Number Formatting

+ Implementation and:monitoring enhancements [see notes]
— G1 is the default collector + new Epsilon GC (no-op), and ZGC
— Java Flight Recorder donated to open source

o New compiler option - -release
— Replaces legacy -source and -target flags

Preface: Java State of the Union 11

Notes:

+ The JVM continues to be improved in terms of scalability (both down and up) and performance.
These enhancements come in forms that we as engineers .can get our hands on and configure,
such as garbage collectors, and also as compile and runtime.changes at the bytecode generation
and execution level, respectively. We won't address the latter.at all. Onthe GC front, in addition to
improvements in G1 (which is now the default), there are some.interesting new ones available:

— The Epsilon garbage collector is a no-op, particularly relevant for short-lived programs that
don't benefit from the cost of GC. http.//openjdk.java.net/jeps/318.

— ZGC is a low-latency concurrent collector targeted at very large heap applications, particularly
installations of big data software like Hadoop. http./openjdk.java.net/jeps/333.

+ Java Flight Recorder has been donated to open source (no longer requiring a commercial license).
http://openjdk.java.net/jeps/328.

Copyright © LearningPatterns Inc. All rights reserved. 11



Java Modules and New Features Preface: Java State of the Union

+ CORBA packages (see ya!) hey, what's CORBA?

« Other overlapping APIs from Java EE

— Java9-10 contained them in the java.se.ee module, which
was marked "deprecated for removal”
. Javasactivation

. Jjava.corba
{java.transaction these are their module names
from java.se.eein JDK 9-10

. java.xml.ws
. java.xml.ws.annotation
java.xml.bind

— Physically gone in 11
» Along with their-associated JDK.command line tools [see notes]

+ Most likely to affect you'is removal of JAXB and JAX-WS

Preface: Java State of the Union 12

Notes:
+ The following JAX-WS tools have been removed:
— wsgen
— wsimport

+ The following JAXB tools have been removed:
— schemagen
- Xjc

Copyright © LearningPatterns Inc. All rights reserved. 12



Java Modules and New Features Preface: Java State of the Union

¢ CMS garbage collector is deprecated
— Support to cease in JDK 14

— G1 is now the default, and long-term replacement
¢ Been around several years now

¢ Some items still "there" but you can't use them ()

—Anternal JDK APls.that are now encapsulated in modules
» Physically, their JARs (rt.jar, tools.jar, etc.) are gone

¢ Some items‘just physically need to go (see ya!)
— Rarely-used GC combinations that were deprecated in Java 8 (?)
— Endorsed Standard and Installed Extension mechanisms
java.endorsedidirs and javasext.dirs
— Outdated JDK command-line tools

Preface: Java State of the Union 13

Notes:

() JEP 260 (Encapsulate Most Internal APIs) states: "..:-make most of the JDK's internal APIs inaccessible
by default [in JDK 9], but leave a few critical, widely-used internal APls accessible, until supported
replacements exist..."

JEP 220 (Modular Run-Time Images) removes rt.jar, tools.jar,/etc., stating that, "some popular
libraries make use of non-standard, unstable, and unsupported APIs that'are internal implementation details
of the JDK and were never intended for external use."

JEP 220 also removed both the Endorsed Standard and the Installed Extension mechanisms.
Upgradeable Modules are intended to replace the Endorsed Standard mechanism, and Installed
Extension is removed with no replacement ("we have seen little evidence of itsuse").

@

-

The following GC combinations were deprecated in Java 8 — http.//openjdk.java.net/jeps/173:
— Incremental CMS, DefNew + CMS, ParNew + SerialOld.

A summary of the JVM flags that configure these combinations can be found here:
http.//openjdk.java.net/jeps/214.

Copyright © LearningPatterns Inc. All rights reserved. 13



Java Modules and New Features Preface: Java State of the Union

¢ Applets deprecated in Java 9 and removed in 11
¢ Java Web Start removed in Java 11, with no replacement
+¢ JavaF X extracted out to OpenFX — http://openjfx.io

¢ Java Client Roadmap Update document describes all of this
— Included in our lab bundle

¢ Java VisualVM (jvisualvm) and Java Mission Control (jmc)
— Extracted out, separate downloads now
— Java Flight Recorder donated to open source
— Mostly done to align‘Oracle JDK with OpenJDK

» As of Java-11, these two are now
"functionally equivalent, with cosmetic differences"

¢ No more JRE
— Instead, build a (smaller!) custom runtime image with j11ink

Preface: Java State of the Union 14

Notes:

+ Note that with all the client-side Ul pieces being extracted out, Swing and AWT are still in.
— Don't need 'em in your application? See "No more JRE" in the slide above...

+ Note that while JVisualVM (jvisualvm) and Java Mission Control.(jmc) are no longer part of JDK
11, and Java Flight Recorder has been donated to open source (no longer requiringa commercial
license), the old standby JConsole (jconsole) is still included.

Copyright © LearningPatterns Inc. All rights reserved. 14



Java Modules and New Features Preface: Java State of the Union

Deprecated - for Removal

+ Number of deprecated classes / methods is always increasing
—Java6 416 items
—Java7 425
—Java8 464
—Java 9+ 627 for removal 24

¢ Java 9 introduced new "attributes" of deprecation
— "since" and "for-removal" now included in a deprecation

@Deprecated(since="1.2", forRemoval=true)

¢ Java 9 marked 24 items for actual removal in future releases

— Some going all the. way back to JDK 1.1 and 1.2 (!)
« Time to finally take this seriously.and change your old code...

+ Java 11 took this to conclusion, physically removing them

Preface: Java State of the Union 15

Notes:

+ The figures above are cumulative, and were obtained.via Java 9's new JDK tool jdeprscan:
— jdeprscan --Tist --release 6 (release is 6|7|8(9)
— jdeprscan --list --release 7
— jdeprscan --1list --release 8
— jdeprscan --1list --release 9
— jdeprscan --1ist --release 9 --for-removal

* The --for-removal option is only applicable for release 9 or later (when "removal" was
introduced).

+ The main use case for jdeprscan is for you to run it on your code, and it will tell you-all the places
you're using deprecated items. (So now you really have no excuse...)

— The commands listed above specify the --11 st option, which simply lists all the deprecations
in the Java platform.

Copyright © LearningPatterns Inc. All rights reserved. 15



Java Modules and New Features Preface: Java State of the Union

When to Move to Java Modules?

¢ The Java Module System is designed to be completely "opt in"
— Some are moving right away
— Some are waiting for more maturity / direction from others

o Using 3rd party libraries as modules will evolve (for the better)
= Adoption has been slow, perhaps one reason to wait a bit

o Our take:
— Get familiar with.modules (it's here to stay)

— Get familiar with the modularity in the Java platform itself,
and how thisaffects your code (because it does!)

— If you make the leap to "modularize" your own code:
 Start small, e.g., common / core libraries, smaller applications
* You'll need to deal with your third party dependencies, too

Preface: Java State of the Union 16

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 16



Java Modules and New Features Preface: Java State of the Union

Thinking in Java 9+

¢ JDK command-line tools have evolved over time
— More options / flags than ever before
— Many of these can now be expressed in several forms:

$ java =cp
$ java -classpath

$ java ==class-path // this 1is the new form
$java -p
$ java) --module-path // this 1is the new form

— NOTE: since some of the new options offer only the new form,
we will be favoring this‘one (in the slide examples and labs)

¢ Course focus is'on "modular” code, i.e., code in a module

— BUT: all the otherplatform improvements are available, even if
you don't "opt in" and modularize your code

Preface: Java State of the Union 17

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 17



Java Modules and New Features Preface: Java State of the Union

LEARNINGPATTERNS

20T 1¢

Lab 0.0: Getting Started

Preface: Java State of the Union 18

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 18



Java Modules and New Features Session 1: Introduction to Modules
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Session 1: Introduction to Modules

Motivation and Overview

Types of Modules

‘ Modular JDK
Our Approach

Session 1: Introduction to Modules 19

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 19



Java Modules and New Features Session 1: Introduction to Modules
Session Objectives
+ Describe shortcomings and problems of the classpath
¢ lllustrate the need for modular encapsulation
¢ IntroduceJava modules
= Definition and structure, module descriptors, modular projects
—How they reference each other, and the modulepath

+ Describe the 4 types of modules

o Describe the modular JDK and.understand how it supports
both modular code-and legacy (non-modular) code

+ Outline our approach tolearning modules in the course

Session 1: Introduction to Modules 20

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 20



Java Modules and New Features Session 1: Introduction to Modules

LEARNINGPATTERNS
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Motivation and Overview

Motivation and Overview

Types of Modules

| Modular JDK
Our Approach

Session 1: Introduction to Modules 21

Notes:
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Java Modules and New Features Session 1: Introduction to Modules

Issues before Java Modules

¢ No strong encapsulation
— Everyone can access a public class
— Private access can be bypassed (reflection)

» Unreliable configuration
— No way. to list. dependencies of a class
=No versioning support
— Classpath Hell aka JAR Hell

« Can't tell in advance if classpath is correct...or complete
* Runtime exception if not

¢ JRE bloat — large monolithic runtime needed for all apps
— But large parts are often unused

+ Java 9 introduced modules to address the shortcomings

Session 1: Introduction to Modules 22

Notes:

+ Wanted: a class needs to be public (so your other packages see it), but not everyone sees it.

+ Java does have explicit import statements, which do two things:
— Let you use the unqualified name of a class.
— Declare a dependency on the imported class.

+ However, imports are a compile-time construct — at runtime, there's-no-telling which JAR(s) on
the classpath contain the class in question, possibly leading to unforeseen‘problems...and
Classpath Hell. The runtime classpath is a flat list — the first JAR that contains the class "wins."

« From http://labs.consol.de/development/2017/02/13/getting-started-with-java9-modules.htmi.

— You probably enough know about unreliable configuration if you have ever experienced
NoClassDefFoundErrors at runtime because of missing dependencies. Or spent hours and days trying
to track down irreproducible bugs in your production environment, just to find out that somehow two
versions of a 3rd party dependency have managed to sneak into your classpath. Most of those issues
originate from the fact that applications written in Java 8 or below do not know about their own
dependencies. Sure - javac won’t compile our code if any compile-time dependencies are missing, and
of course we have build tools and IDEs to support us with those. However at runtime, the JVM needs to
lookup required classes in the classpath again, in some cases resulting in different classes being loaded
by the classloader. When these things happen, they usually do during runtime. Ouch. And more often
than not, tracking them down is a painful experience.
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A Natural Progression of Organization

+ Class definition  collection of related data and functions
¢ Package collection of related classes
¢ Module collection of related packages |but of course!

# |s this really needed? Look at any decent-sized library

+ Spring
— database-related packages: 33
— web-related packages: 103
— test-related packages: 30

+ Java Platform API
— Ul packages: 33 +15 (if you count'sound and imaging)
— XML packages: 35

Session 1: Introduction to Modules 23

Notes:
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Package-Level Encapsulation

¢ Packages are created for organizational purposes

& Result is often several subpackages per functional area.. ..
or ... stated differently, per module

e N
com.company.app.db
com. company.. app.db|.api

com.company.app.db|.provider. jdbc
com.company.app.db|.provider. jpa
\gom.company.app.dg.provider.ext

¢ These packages need to interface with each other — so
some classes.are made public

— Some developers-will even write all their classes to be public . . .

¢ BUT every public classis now exposed to the entire universe

Session 1: Introduction to Modules 24

Notes:
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Java Modules and New Features Session 1: Introduction to Modules

Modular Encapsulation — Not in Java 8

¢ \We all understand exposed vs. encapsulatec
— Agraphic from our Intro Java course

Exposed details

¢ In Java8, there is no way to group a set
of related packages

~ Exposing some
—\While hiding others

¢ Result looks like this:

_ com.company.app.db
any outside code com.company.app.db.api

com.company.app.db.provider. jdbc
com.company.app.db.provider. jpa

com.company.app.db.provider.ext

Session 1: Introduction to Modules 25
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Internal Use Only - Case Study

+ The following is direct from the Spring APl documentation

¢ Package org.springframework.objenesis
— Spring's repackaging of Objenesis 3.0 (with SpringObjenesis
entry point; for internal use only)

— This repackaging technique avoids any potential conflicts with
dependencies on different Objenesis versions at the application
level or from third-party libraries and frameworks

¢ Why are they,doing this?
— "this technique avoids potential conflicts with dependencies”
— In other words, they've been to JAR Hell too many times!!!

more on this later
o NOTE: Java Modules does NOT address the "version problem"

Session 1: Introduction to Modules 26

Notes:
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Conceptual Model vs. Runtime Model

+ Conceptual picture of your application
— Easy to see how it all fits together . . .

bookstore

books.impl

Session 1: Introduction to Modules 27

Notes:

+ Taken from http://slideshare.net/SanderMak/migrating-to-java-9-modules.
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Conceptual Model vs. Runtime Model

+ Actual view of your application

CLASSPATH=1ib/ant1lr-2.7. 7. jar:lib/cdi—api-1.1.jar: lib/classmat
e41.3.8.jar: lib/commons—dbcp-1.4.jar: lib/commons—Llogging-1.2.]
a@r: L\t commons—pool-1.5.4.jar:1ib/dom4j-1.6.1.jar: lib/el-api=-2
vesjar:ldt¥hgeronimo—jta_l .|~1 vlelejar:lib/hibernate—commons—ann
otagdons-5.8.1.Final.jar: Lib/hibernate-core-5.2.2.Final. jar: L1
b/hibern@te—jpa-2.1-api-1.0.0.Final.jar:1lib/hsqldb-2.3.4.jar:1
ip/jandex—@.8.8.Figal.jar:lib/javassist-3.20.8-GA.jar: lib/java
x\ipject-1%jar: ldb/jboss—-interceptors-apil_1.1 spec-1.8.8.Betal
. jafe-ib/jbosSsSlogging~3.3.8.Final.jar: lib/jcl-over-s1f4j-1.7.
21.jarddb/jsri§8-api-1.8,.jar: 1ib/ logdj-api=2.6.2.jar:lib/logd
j—core-2.642,.jar: libis®T4)-api-1.7.21.jar: 1ib/s1f4j-simple-1.7
«21.jar: libfepring—aop=<d4y3.2.MELEASE.jar: lib/spring-beans—4.3.
2.RELEASE.japé)ib/spring-conté®t-4.3.2.RELEASE.jar:1ib/spring-
core—4.3.2.RELEASE.jar: libjSpring#expression—4.3.2.RELEASE. jar
: Lib/spring—-jdbc—443.2.RECEASE.g8r: Lib/spring—orm—-4.3.2.RELEAS

E.jar:lib/spring-tx=4)3.2. RELEASECTar

Session 1: Introduction to Modules 28

Notes:

+ Taken from http://slideshare.net/SanderMak/migrating-to-java-9-modules.

+ Take a close look at the JARSs in this classpath — recognize-any?

— Some of these JARs turn up everywhere, and your application will not run without them, yet
you're not using them from your code.

— Must be that the libraries you call into are using them.
* Now, without Maven or Gradle to help you, how would you know that?
— Seriously, do you even know what ant1ris? (No, it's not a Java API forhunting deer.)

Copyright © LearningPatterns Inc. All rights reserved. 28
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Classpath Hell

¢ We've all been there

at some point... - MR HELL -

NoClageDefFoundError

Session 1: Introduction to Modules 29

Notes:
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Adopters of the Module Paradigm

¢ JBoss Application Server has its own module system

— Different purpose than Java modules — it's about packaging
and deployment of applications and dependent libraries (JARS)

— Game=changing architecture for Java EE app servers

+In JBoss, all dependencies must be explicitly listed

—Ancluding.your applications' dependencies
« Burden on the developer, but you get exactly what you want
» Not just the first one found on the classpath at runtime

+ This has several high-level similarities to Java modules

Session 1: Introduction to Modules 30

Notes:

+ On any appserver, having multiple versions of the same library is not uncommon — different
applications use different versions, and the server itself.might use yet another/version. There is
also usually a tension between WEB-INF/Iib and <server-root>/lib, i.e., which has-precedence in
the hierarchical classloader model, leading to yet another dismal place — Classloader Hell.

+ JBoss Modules is a powerful deployment and classloading model.

— It helps JBoss users solve dependency problems for applications. “Effectively, there is.nolinear
classpath (searched left-to-right, first-class-found-wins) — all classes are resolved via module
lookup. Nothing is "left to chance."

— It also drastically speeds up server start time and class initialization at runtime; because
classes are found so quickly and efficiently — via module lookup instead of flat classpath.

+ Disclaimer: this is not an endorsement of JBoss. We mention it only because it provides a useful
example of how a module-based system can solve myriad problems that have been plaguing Java
developers for years.
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Module Graphs

¢ Modules and their dependencies form a module graph
— This example is from JBoss Modules

—We'll show Java module graphs later org. framework.xml
fw-xml-2.1.jar :

dependencies

com.javatunes.core
core.jar |

dependencies

org.useful.util

util-1.0.jar

com.javatunes.services

message-service.jar

FVIGE org.useful.util
catalog-service.jar

util-1.1.jar

dependencies

Session 1: Introduction to Modules 31
Notes:
¢ In JBoss, a module is a named set of JARs. = | .org
1.1
— This is defined in a module descriptor called module.xml, = useful | _
and the JARs are usually colocated with it. This module % Man
descriptor also lists the other module(s) that this module | L1
depends on. | main 4

— These files are stored in a Maven-like repository structure,
which must match the module name. In this screenshot,
you can see the two version slots for org.useful.util - "main" and"1.1".
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Introducing Java Modules

+ Module = named set of packages + module descriptor
— module-info.java at root of its package hierarchy

module com.company.app.db {
exports.com.company.app.db;
exports com.company.app.db.api;
requires-java.sql;

// dependencies on
requires java.persistence; // other modules
X

// exposed packages

+ Exported packages are visible to other modules
— IF the other module requires this one

o This module reads java.sql + java.persistence (V)
— Read a module = has access to its exported packages
— Specifically, the public classes in those exported packages

Session 1: Introduction to Modules 32

Notes:

& Module = named set of packages.

— Packages that are exported are visible to other modules.
* Provided that those modules read this module.

— All other packages in the module are encapsulated.
« Hidden, and inaccessible to other modules.

+ IMPORTANT: a module exposes packages and depends on (requires) other modules.

() This module requires modules java.sql and java.persistence

— We say that module com.company.app.db reads modules java.sql and java:persistence.
— The two modules are said to be read by this one

Copyright © LearningPatterns Inc. All rights reserved. 32
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Modular Encapsulation - Realized in Java 9

¢ The 'client' module reads the 'db' module
— Note which packages it has access to

module .com.company.app.client { module com.company.app.db {
requires_com.company.app.db; exports com.company.app.db;
} exports com.company.app.db.api;

requires java.sql;
requires java.persistence;

exposed
¢ Inside the module: com.company .app.db

) com.company.app.db.api
— Normal VISIbI|It.y rules encapsulated
(class vs. publicclass) :

Session 1: Introduction to Modules 33

Notes:

+ Likewise, the 'db' module reads modules java.sqland. java.persistence.
— So it has access to the exported packages in those modules.
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Module Name vs. Package Name

+ This can get confusing — you'll just have to adapt

¢ Recall: module = named set of packages
— Java'SE platform modules are named java.something
— Myriad‘packages are named java.something

¢ Module java.sqlrexports these packages:
- javassql
- javax.sql

see the possible confusion?

+ This can get confusing— you'll just have to adapt |deliberate reprint

+ See notes for additional thoughts on module naming

Session 1: Introduction to Modules 34

Notes:

+ In many cases, the module name will match some part of its packages' names.
— Arguably, the module name "java.sql" in the slide‘is a good name for these 2 packages.

+ As another example, in our earlier demo module in the slides, com. company.app.db is certainly a
suitable module name for these packages:
— com.company.app.db
com.company.app.db.api
com.company.app.db.provider. jdbc
com.company.app.db.provider. jpa
com.company.app.db.provider.ext

+ This is a common naming pattern — use the top-level package's name as the module name.

+ You will also see module names that adhere to this basic pattern, but omit the "com" or "org" prefix,
etc., resulting in something like company.app.db, or even just app.db.
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Modules and Directory Structure

¢ Convention: module base directory = name of module
— Module descriptor lives in module base directory (required)
— Package directories live under the module base directory
— Packaged into a standard JAR — a modular JAR
— Below.are some packages from the java.base module

src modules
I I
java.base java.base
module-info:java java module-info.class java
util lang util lang
e N / AN
Date.java String.java Date.class String.class
Collection.java System.java Collection.class System.class
Session 1: Introduction to Modules 35

Notes:

+ lItis not strictly required that the module base directory be named afterthe module, but this is a
very common convention, and we strongly recommend-doing it this way.

— There are some very good reasons for this convention, only one of which is-clarity and
organization. We'll see other benefits later in the course, in-lab.

+ There are two structures for file organization in modular projects —
single-module and multi-module.

— In the single-module structure, all the source code, including package-directories and the
module-info.java file, resides directly under the single base directory, e.g.;-src.

* In this model, you can only have one module per source tree, since you.can only have
one module-info.java file in a given base directory.

— In the multi-module structure, you can have multiple modules in one source tree, each one
rooted at its own base directory named after the module.

* In this model, it is required that the module base directory = the module name.
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Session 1: Introduction to Modules

Modular Projects and the Module Path

+ Partial layout of demo app

B

demo-app

(= Src

com

¢ JDK tools have been

updatedto support modules

— Commands below are run
from demo-app directory

¢ See notes for more details

\

= . com.company.app.client

=

com
company
app

module-info.java

client )

(E| com.company.app.db A
= com

=
=
=

COmpan
app

db

no spaces!

# compile both modules, each one treated
$ javac -d modutles, --module-source-pat
--module com.company.app.clien

as a single unit of code
rc
om.company.app.db

0

# module-path supports multiple entries.using separator char for 0S
# main-class is specified via --module module-name/main-class

$ java --module-path mlibjmedules

--module com.company.app.client/com.company.app.client.Main

Session 1: Introduction to Modules 36

Notes:

¢ Each module in the project is contained in its own module-base directory, named after the module.

This is the multi-module structure. (See notes previous-page.)

When using this layout, each module directory tree can be compiled as a "unit of code," and the compiler
will create a mirror image of this structure, rooted under a modulles-directory
(because we specified a '-d modules' argument which specifies the-destination directory).

javac: module-source-path option specifies locations of source files for multiple modules

- module option specifies the modules to compile

¢ When launching the application (java), the
--module-path argument specifies location(s) of
modules. Similar to classpath, with a few differences:

— The locations must refer to modules, i.e., JARs
with module-info.class at the root (modular JAR),

or an exploded version of this.

It can also refer to a containing directory of
modules, i.e., you can set --module-path to
refer to a lib directory, and all modular JARs in
that directory are automatically found. Nice!

* This means that, unlike the classpath, a
module path is typically not a mile long!

--moduTle specifies main class in form module/mainclass

= demo-app

com
=] modules

module-info.class

= . com.company.app.client

=] com
= company
= app

client
com.company.app.db
= src
=] com.company.app.client

= com
=] company
=L app

client
com.company.app.db

Copyright © LearningPatterns Inc. All rights reserved.
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Modules Can Be Controversial

+ Disagreements during specification phase
— Remember the JCP, Oracle is not the boss...
— May 2017: committee rejected module system in its current state
—June2017: approved in a 2nd vote (after changes were made)

¢ Modules can break existing code

—While designed to be an opt-in technology, there are cases in
which Java 8 code will not run out of the box on newer JVMs

o Is it better?
— Most would agree that'Classpath Hell / JAR Hell needs to go

— Controversy remains wrt how much net benefit modularizing
your code provides.~ are we heading toward Module Hell? &

— More on this later

Session 1: Introduction to Modules 37

Notes:

& Project Jigsaw (JEP 261: Module System) took a long time to completely materialize into
implementation. It was initially planned for Java 7, obviously that didn't happen. Same story for
Java 8. Finally arrived in Java 9.

— To be fair, it was no small feat to introduce such a drastic.change to Java, while still
maintaining compatibility, and providing a means of migration to the new module system.

* And keep in mind how large the Java platform has grown.
* You'll get a better sense of the sheer size of this effort once you start to modularize just a
single application(!)

— Add to this the committee nature of developing new Java specifications —these things can take
awhile...

+ The most likely future scenario is that, over time, this modular approach will become the norm. The
migration issues will be over, your team will understand how it all works (there is certainly more
complexity involved), and the tools and IDEs will have fully adapted.

— Currently, however, some critics say that more work needs to be done, especially with regard to
version selection and integration with build tools (both of which the module system in its current
form does NOT provide).
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LEARNINGPATTERNS

20T 1¢

Lab 1.1: First Module Project

Session 1: Introduction to Modules 38

Notes:
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LEARNINGPATTERNS

Y 1§

Java Modules and

New Features (Java 11+)
Lab Manual - Eclipse

Copyright © LearningPatterns Inc. All rights reserved:

Version 20200306

Notes:
¢ Version 20200306
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Labs: Java Modules and New Features Introduction

Release Level %

+ This manual contains instructions for creating and running the labs
using the following software packages:

— Java SE 11 (LTS. Tested with 11.0.5)
» Later versions (e.g. Java 12) will likely work, but have not been tested
— Eclipse.IDE for Enterprise Java Developers — 2019-06 or later

¢ Instructions‘are geared towards Windows-based operating systems
— You'should easily be able to adapt to other environments, e.g., macOS

Introduction 2

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 2
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LEARNINGPATTERNS

20T 1¢

Lab 0.0: Getting Started

Lab 0.0: Getting Started 3

Notes:
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Lab Synopsis w

o Overview:
— Examine new directory structure of JDK 11 installation
— Extract and review the Java 11 API documentation (Javadoc)

— Verify environment setup to do command line work with the JDK
« JAVA_HOME and PATH

— Work with/'some very simple Java 8 demo applications on Java 11
» Do they work unchanged on Java 11?

¢ Builds-on previous labs: none

¢ Approximate time: 20-30 minutes

Lab 0.0: Getting Started 4

Notes:
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Information Content and Task Content w

+ Informational content is presented in the normal way — the same
as in the student manual

— Like these bullets at the top of the page
o Tasks you need to do are in a "Tasks to Perform" box

Tasks to Perform

¢ Look at these.instructions, and notice the different look of the box
— Make a note of how it looks, as future labs will use this format

+ Make sure that you.have Java 11 installed
— Likely in a'directory such.as C:\Program Files\Java\jdk-11.0.5 ()
— If not, you'll need to install it — it can be downloaded from:
http://oracle.com/technetwork/java/javase/downloads

¢ OK - now get out your setup files, we're ready to start working

Lab 0.0: Getting Started 5

Notes:

(M On macOS, the JDK is typically installed under /Library/Java/JavaVirtualMachines/jdk-11.0.5.
— On Linux, it may be in various places. Ask your instructor if you can't find it.

+ The setup files may be on your workstation, or they may be provided by your instructor.

Copyright © LearningPatterns Inc. All rights reserved. 5
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Extract the Lab Setup Zip File %

+ To set up the labs, you'll need the course setup zip file
— Ithas a name like: LabSetup _Java11New 20200306.zip

+ Ourbaseworking directory for this course will be
C:\StudentWork\Java11New

— Gets created when we extract the lab setup zip
= Ancludes a directory structure and files needed in the labs
— Allinstructions assume that this zip file is extracted to C:\
If youchoose a different directory, please adjust accordingly

Tasks to Perform

+ Unzip the lab setup file to C:\

— Creates the StudentWork/Java11New directory structure, containing
files that you will need-for doing the labs

Lab 0.0: Getting Started 6

Notes:

+ The setup files may be on your workstation, or they may be provided by your instructor.

Copyright © LearningPatterns Inc. All rights reserved. 6
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Review Lab Folder Structure w

StudentWork
Copyright.txt

— Derby/DerbyLib: Database files
— LabSetup: Additional Lab Files
~ Resources: Documentation

— Software: Utilities for labs

— workspace: Lab code (both Eclipse based
and command line)

JavallNew

Derby

workspace

common

contain the following folders:
— LabNN : Folder for Lab NN, containing:
* build files: For non-Eclipse builds
» src/ or src/module.name: Java.source

* bin or modules/modules.name :
compiled code

Lab02.1_javatunes._client

.propertes

. « StudentWork\Java11New\workspace will E

Lab02.1_javatunes.domain
Lab02.Z_javatunes persistence
_________________________________________ | ak0T 3 avatiinac norcictomes imey
Lab 0.0: Getting Started 7

Notes:

¢ Some labs are not modular.

— Those labs will be laid out with source code under the src folder, and compiled code directly
under bin (all in package folders, of course).

— This is the standard Eclipse Java project layout.
+ Some labs are modular.

— Those labs will be laid out with source code under the src/module.name folder, and compiled
code directly under modules/module.name folder (all in package folders, of course).

— This is the Java standard layout for modular projects, which is not always required, but strongly
recommended.

— Eclipse does not always automatically set all of this up for you (unfortunately);-but we will set it
up as we create individual projects.

Copyright © LearningPatterns Inc. All rights reserved. 7
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Review the JDK Installation w

Tasks to Perform

+ Using Windows Explorer, navigate to the JDK installation
— On Windows, this is C:\Program Files\Java\jdk-11.0.5 or similar
— We refer to this as <jdk-install>, <jdk-home>, or <jdk>

bin
conf
+ Take a few.minutes and look around docs
Z'NOTE: youwon't have a docs directory yet ;’;f:j:
« Used.in building custom runtime images with j1ink i

— The actual runtimeimage of the platform modules is lib/modules
* 100MB+ single binary file
* No more rtjarand the like, as in previous versions

o Open <jdk-install>/README.htmland follow the link
— From here, you can get to all the documentation, for several releases

Lab 0.0: Getting Started 8

— Platform modulesiin jmods directory, as .jmod files legal i

Notes:

¢ On Mac, the Java install location is generally
/Library/Java/JavaVirtualMachines/jdk-11.0.5.jdk/Contents/Home

+ On Linux, locations can vary, but some common ones are:
User home folder

/usr/lib

{usr/local

lopt
— etc.

+ To get the release notes, you can also go to java.com/licensereadme
— From that page, follow the link to the JDK 11 Readme.

Copyright © LearningPatterns Inc. All rights reserved. 8
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Extract the Platform API Docs w

+ We've provided the Java Core API docs (Javadocs) in the lab setup
— In.StudentWork/Java11New/Resources/jdk-11_doc-all.zip
— Nice to have it installed locally, no dependence on Internet connection
— These docs are good for any Java 11 version, and for many later ones

Tasks to Perform
+ Do an "extract to here" using a zip tool, which yields a docs folder
— You-can just browse them from here
— Or, move that entire docs tree to <jdk-install>

« Adviseyou cut /'move the directory tree, NOT copy it (can be very slow)
— Start at index.html

o Looks familiar, but the front page Java SE 11 & JDK 11
is modules now, not packages

— NOTE the Search field upper right! ©

Lab 0.0: Getting Started 9

SEARCH: |\ Search %

Notes:

+ On a Windows system, you may not be able to extract'the zip directly into the Java installation
directory, because it's under the special "Program Files*directory. As a workaround, you can
extract to a temp directory, or do an "extract to here," then'move (don't copy) the resulting docs
directory to <jdk-install>.

+ Though these are Java 11 docs, most of it will remain the same for later technology release
versions — e.g. Java 12 or 13.

Copyright © LearningPatterns Inc. All rights reserved. 9
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Verify Environment w

+ We'll need to use the JDK tools from the command line
— Several new tools, and new options to existing tools

+ Setting this up was requested to be done before the start of class
— Be sure totake care of it now if needed

Tasks to Perform
¢ SetJAVA_HOME and modify PATH
— JAVA-HOME environment variable should point to your <jdk-install>

— PATH environmentvariable should include JAVA_HOME/bin :
* This is JAVA_HOME%\bin on Windows, $JAVA_HOME/bin on macOS E

¢ Open command prompt andtest — see notes
$ java -version
$ javac -version

Lab 0.0: Getting Started 10

Notes:

¢ These steps are SOP (standard operating procedure).for any Java developer, and should be
familiar to you.

C:\StudentWork\JavallNew>java -version

java version "11.0.5" 2019-10-15 LTS

Java(TM) SE Runtime Environment 18.9 (build 11.0.5+10-LTS)

Java HotSpot(TM) 64-Bit Server VM 18.9 (build 11.0.5+10<LTS, mixed-mode)

C:\StudentWork\JavallNew>javac -version
javac 11.0.5

Copyright © LearningPatterns Inc. All rights reserved. 10
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Compatibility with Existing Java 8 Code LL0E

+ We've provided two very simple demo applications written in Java 8

— StudentWork/Java11New/workspace/Lab00.0,

each in its own directory
. = date-client-8
+/ date-client-8 e
* sjaxb-client-8 src
=] jaxb-client-8
+ They've been working great for years! E:sses
—~ What happens when we move them to Java 11? src

Tasks to Perform

¢ Open a command promptto date-client-8

: — Execute the appropriate run script for your OS — run.cmd or run.sh
E « Should run ok =three dates, from the 'util’, 'sql’, and 'time' packages

— Review the run script in an<editor = nothing special going on

¢ Try to compile/run it on JDK 11, using our build/run scripts ()

Lab 0.0: Getting Started 1

Notes:

(™ 1t should compile fine. Then review the build script = again, nothing fancy.

— Try running it again via the run script. Should run as before. These are JDK 11-compiled
classes now.

— Looks like this one works fine on Java 11!

Copyright © LearningPatterns Inc. All rights reserved. 11



Labs: Java Modules and New Features Lab 0.0: Getting Started

Compatibility with Existing Java 8 Code

Tasks to Perform
+ Now we'll examine the jaxb-client-8 application
— In your command prompt, change directory to jaxb-client-8
— Again, execute the appropriate run script for your OS
— Looks like'we've got a problem!

Exception in thread "main" java.lang.NoClassDefFoundError:
javax/xml/bind/JAXBContext

— Now. run it via run-11 script — works this time
* You'll see a "book marshalled" message
» The marshalled books are'in the books subdirectory, in XML files

+ Review and compare the'two scripts: run and run-11

— The run-11 script.adds a JAXB implementation (and its dependencies)
to the classpath — this‘is needed,; because Java 11 removed JAXB

+ Now run and review both ‘build scripts: build and build-11®

Lab 0.0: Getting Started 12

Notes:

() The bui1d script fails and the buil1d-11 script succeeds, for the samereason: build-11 adds
JAXB to the classpath.

Copyright © LearningPatterns Inc. All rights reserved. 12



Labs: Java Modules and New Features Lab 0.0: Getting Started

Observations %

+ Modules are completely "opt-in"
— You don't have to change your Java 8 code to be "modular” to run it

¢ There are'several caveats though, and we've seen one here
— date-client runs fine on Java 11, with no changes necessary
» Can also recompile it with JDK 11 no problem
=jaxb-client runs fine on Java 11, BUT we had to add JAXB back in
« JAXB and other overlapping packages from Java EE have been removed
— All'in-all, not too big a problem — just a few JARs added

¢ NOTE: this is all because it's a‘classpath-based application
— Our application.code is not in a module
— Our code and the-3rd party libraries (JAXB) are on the classpath

— We get to use everything defined in platform module java.se —
this module represents the "entire" Java SE platform [see notes]

Lab 0.0: Getting Started 13

Notes:

+ With caveats — some of which are things like JAXB being removed, some of which involve deep
reflection into platform classes. We will examine this in.-more detail in the next section.

Copyright © LearningPatterns Inc. All rights reserved. 13



Labs: Java Modules and New Features Lab 0.0: Getting Started

Additional Research [Optional] w

+ We've provided several useful ReadMe files and accompanying
filesets in the lab bundle, in an organized folder structure

— StudentWork/Java11New/workspace/Lab00.0_Optional

Tasks to Perform
+ Outside of class time (lunch, evenings, etc.), we recommend you
takea look

— An important one is the java-support-updates-roadmaps folder

+ We strongly suggest you look at this one, even if you don't bother with any
of the others — start at the usual place: ReadMe.txt

Lab 0.0: Getting Started 14

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 14



Labs: Java Modules and New Features Lab 1.1: First Module Project

LEARNINGPATTERNS

20T 1¢

Lab 1.1: First Module Project

Lab 1.1: First Module Project 15

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 15



Labs: Java Modules and New Features Lab 1.1: First Module Project

Lab Synopsis w

+ Overview - this lab has two parts:
— Part 1: build and inspect a multi-module project, via command scripts

— Part 2: import a Java 8 application into the IDE and make it modular

» NOT a full-scale migration exercise, but illustrates some of the differences
between "old" and "new" — Java 8 code vs. Java 9 code, and classpath vs.
modulepath

+ Builds on previousdabs: none

¢ Approximate time: 25-35 minutes

Lab 1.1: First Module Project 16

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 16



Labs: Java Modules and New Features Lab 1.1: First Module Project

Part 1: Multi-Module Project w

+ We've provided a "full version" of the demo app from the slides
— The com.company.app demo used to illustrate the basics of modules

—It'sjust a few source files, but it uses the customary project layout, and
allows us to get familiar with modular projects

Tasks to Perform
+ On‘the filesystem, use Windows Explorer and navigate to
StudentWork/Java11New/workspace/Lab01.1_demo-app

|
|
|
— Expand the srcfolder and note the two module base directories :
. com.company.app.client i

. com.company.app«db |
|

|

|

|

|

|

— Each contains module-info.java and a standard package structure
+ Drill down into’each one and.open a source file or two for brief review
» Standard package and import statements, very simple Java code

+ Next, we'll work with some build and run scripts ——

Lab 1.1: First Module Project 17
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Labs: Java Modules and New Features Lab 1.1: First Module Project

JDK Tools with Modular Project w

Tasks to Perform
¢ Open a command prompt to the project base directory,
Lab01.1_demo-app

— Open the build script (.cmd or .sh) for review — note how it's compiling
modules, not sets of individual source files

— Openthe build-jar script for review — nothing new here (1)

+ Execute the scriptsifirst build, and then build-jar
— See'instructor if you get errors
 Likely'a'simple JAVA HOME and/or PATH issue with your setup

— Examine thefilesystem
» A modules directory structure of .class files that mirrors that of src
« An mlib directory with modular JARs @

+ Open the run script, review it, then run the application )

Lab 1.1: First Module Project 18

Notes:

() Reminder: since some of the new options to the JDK tools offer only the "--new-form", we will be
favoring this one.

— For example, jar options --create and --f1ile instead.of the traditional -cf.

— Note also that we will break our own rule — in particular, we'tend to favor ~classpath over the
newer --class-path. Old habits die hard...

— Of course, all the old flags are still supported.

@ There is nothing special about our choice in using an "mlib" directory instead of something like lib.
We're just emphasizing that these are modular JARs.

4 The application gets executed twice — first with a modulepath of exploded modules, and then with
modular JARs. This means it won't run unless you've run both build and build-jar beforehand.

— In both cases, the modulepath is set to the modules' containing directory, i.e., the directory
above the individual modules.

Copyright © LearningPatterns Inc. All rights reserved. 18



Labs: Java Modules and New Features Lab 1.1: First Module Project

Module Descriptor and Resulting JARs w

Tasks to Perform
+ Open both module descriptors using any text editor (not Notepad)
— That is, each module's module-info.java file
— 'cl1ient"module requires 'db' module and exports no packages
— 'db' module exports 2 packages out of its 5 packages total

¢ 'Inspect the modular JARs
—'Open them with any zip utility, notice module-info.class at the root
— Then, use the jar utility to inspect them () ()

$ jar -~file mlib/app-client.jar --describe-module
$ jar -f mlib/app-clienti.jar -d # shorter, same meaning

— Notice the following in the output:
» An "exports" or "requires" for each directive in the descriptor (obviously)
« Each one "requires java.base mandated" — this is important
* Encapsulated packages (not exported) are listed as "contains"

Lab 1.1: First Module Project 19

Notes:

() Remember! Forward slash (/) on unix, backslash (\).on Windows.
We generally show forward slash (/) in the slides.

We will revisit this technique in more detail later, which is especially useful when'dealing with
library or other JARs that were not created by you. This is something you'll encounter when doing
a migration.

Copyright © LearningPatterns Inc. All rights reserved. 19



Labs: Java Modules and New Features Lab 1.1: First Module Project

Modular Encapsulation - Demonstrated w

¢ Let's see strong encapsulation in action

— As structured, all the classes in this project need to be public *
* Not a flawed design, but one of the consequences of Java 8 visibility rules
» The classes in the 'provider' packages are visible to the 'c1ient' package
»This changes once we go modular

Tasks to Perform

¢ Openi com.company.app.client.Main in an editor (not Notepad)
— Look-for the TODO and perform the task
— Read the compiler.error —does it make sense?

+ Comment back-out the offending line of code and rebuild the project

+ You can close the command prompt
— We'll be working in the IDE for this'second part

Lab 1.1: First Module Project 20

Notes:
*  Why would this be so?
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Labs: Java Modules and New Features Lab 1.1: First Module Project

Part 2: Module Project in the IDE w

Tasks to Perform

¢ Launch Eclipse: go to C:\eclipse and run eclipse.exe
— A dialog box should appear prompting for a workspace location ()
— Set workspace location to C:\StudentWork\Java11New\workspace
— If a different default workspace location is shown, change it
— Don't import any projects — just open the workspace )

'CF Edlipse IDE Launcher il

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: |C:HStudentWork\Java11New\work5pace j Browse... |

[ Use this as the default’and do not ask‘again
» Recent Workspaces

. Launch |  Cancel

Lab 1.1: First Module Project 21

Notes:

() If the workspace dialog box does not appear, that means that Eclipse was previously launched on
your system, a workspace directory was chosen, and the "Use this as the default..." box was
checked.

— In this case, you should change workspace to that shown .above via:
File > Switch Workspace > Other... This will open the dialog box.

2 NOTE: you must use our provided workspace directory, as we've supplied starter code-and
other files for some of the labs here.

@) You should not do anything but open Eclipse using the correct workspace here.

— In particular, you should not import any project folders you see. We'll explain how to use these
all correctly later, and it's important to wait until then.

+ If Eclipse was installed elsewhere, adjust the path to the Eclipse executable accordingly.

+ You can also put a shortcut on your desktop to start Eclipse.

Copyright © LearningPatterns Inc. All rights reserved. 21



Labs: Java Modules and New Features Lab 1.1: First Module Project

The Eclipse Platform %

+ Eclipse (www.eclipse.org) is an open source platform for building
integrated development environments (IDEs)

— Used mainly for Java development — can be extended via plugins and
used in other areas (e.g., C# programming)

¢ Originally developed by IBM
~ Released into open source
— IBM's RAD productline is built on top of Eclipse

o Eclipse products have two fundamental layers:

— Workspace: files, packages, projects, resource connections,
configuration properties - all stored on the filesystem

— Workbench: editors, views, and perspectives — the Ul you work with

+ We will set up the workspace and workbench, then do our lab

Lab 1.1: First Module Project 22

Notes:

+ The workbench sits on top of the workspace and provides visual artifacts (the Ul) that allow you to
access and manipulate the underlying workspace resources.

Copyright © LearningPatterns Inc. All rights reserved. 22



Labs: Java Modules and New Features Lab 1.1: First Module Project

Workbench and Java Perspective

Tasks to Perform

¢ Close the Welcome screen and open a Java Perspective

— Click the Perspective icon at the top right of the Workbench and select
Java (see below left and below center)

: — See notes-about perspective icons and theme (look and feel)

+ Close the Java EE perspective by right-clicking its icon at the top
right of the Workbench and selecting Close (see below right)

— The Java EE perspective is the default for the Eclipse Java EE version

MPEIET

| 2% | #® Java EE | & Java

: [3xDatabase Debug
| = || 2 JavatE (3 Databasé Development
3 Debug

&y Java Browsing
2 Java EE (default)
2! Java Type Hierarchy

Lab 1.1: First Module Project 23

Notes:

+ NOTE: the perspective switcher does not show the perspective name by default. To change this,
right-click on any perspective icon and Show Text — see examples below.

[
. s | Al il i | 22 java BE &) Java
* -] 1| — s o8
E | Fa Ei" Close E~

" with fabels
T aas— |

+ Many of our screenshots use the "classic" theme, colors, and fonts.

— This may not be what your version uses, which is OK. It shouldn't cause any confusion.
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Labs: Java Modules and New Features Lab 1.1: First Module Project

Customize the Perspective %

1
| Tasks to Perform !
I L] L] " !
. ¢ Unclutter the perspective by closing some views !
1
. . — Close the Task List and Outline views i
! . - -
. ¢ Open the'Console view: Window > Show View > Console |
! .
‘¢ You can save these changes to the perspective (see notes) :
-lalx]
File  Edit Navigate Search Project Run Window Help
@Rt~ e~ By~ B wi~ily =
) N 4 _ Quick Access || & ||& Java
[3-Package Explorer 8 [ \i,| 2 ¥ = B8 =g
[, Proﬁeng% B Console ¥ =8
(0 items
‘ Description | Resource Path | Location |
4 | y _ | ﬂ
Lab 1.1: First Module Project 24

Notes:

+ An Eclipse perspective is simply a collection of views, shown as tabbed panes in the Workbench.

— A perspective defines which views are included, where)they are positioned, and what their
relative sizes are in the Workbench.

+ Eclipse has several predefined perspectives, which can be used as-is;.or customized to suit.your
needs / preferences. There's a good chance you'll want to tweak the ones you're using.

— To customize a perspective, open a predefined one, e.g., the Java perspective,‘close the views
you don't want, open any views you do want, reposition and/or resize them; and then save the
changes via Window > Perspective > Save Perspective As...

» TIP: to preserve the factory-shipped perspective and create a brand new perspective'based
on it, use a different name, e.g., "Java [YI]", where "[YI]" are Your Initials in square brackets.

* Window > Perspective > Save Perspective As... > Java [YI].

+ Your instructor may also recommend additional customizations, which s/he will go over with you.
— There are myriad settings, all available via Window > Preferences.
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Labs: Java Modules and New Features Lab 1.1: First Module Project

Create Module Project (1 of 2) w

Tasks to Perform

+ Check the Eclipse preferences to be sure you are using Java 11
— Window > Preferences - Java - Installed JREs
'I:}New Java Project
+ Create a new Java project Create a Java Project
N F|Ie N New N Java Project Create a Java project in the workspace or in an external loca

— Name it exactly Lab01.1_date-client
« "\Becomes project.root folder name
» Picks up any starter code - noted in Eclipse info message below

~
(Eroject name: | LabDl.l_date—cIientJ

(D) The wizard wilautomatically cenfigure the JRE and the project layout based on the existing source.

¢ Click Next, andin‘the Java Settings | - & Projects
dialog, note the src/example.date
source folder 18 Lab01.1_date-client
Continue on next slide > (L= wovample e )
""""""""""""""""""""""""""""" Lab 1.1: Fist Modue Proect 25
Notes:

() IMPORTANT NOTE: you must name the project Lab01.1_date-client; in order to pick up the
starter code we've provided for this lab.

— That's because the starter code was preprovisioned in the.workspace/Lab01.1 date-client
directory (in appropriate subdirectories).

— By naming the project Lab01.1_date-client, the project directory defaults to workspace/
Lab01.1_date-client, and the starter code is automatically recognized and included.in the
project's fileset.

+ NOTE: we are deviating from Eclipse's default directory structure for source and output files for.a
standard Java project, which is normally src and bin, respectively.

— We are instead using the common convention of sre/module.name for source files, and
modules/module.name for compiled .class files.

— We have source in src/example.date, and that IS picked up automatically by Eclipse as a
source folder, replacing the default src/ folder.

— Sadly though, it still defaults to bin for compile .class files.

— We change that in the extra steps we're taking here. Later, we'll show how Eclipse can
automatically set the correct output folder based on the existence of .java and .class files in the
correct places.

Copyright © LearningPatterns Inc. All rights reserved. 25



Labs: Java Modules and New Features Lab 1.1: First Module Project

Create Module Project (2 of 2)

Tasks to Perform
¢ In lower left of Java Settings, Uncheck "Create module-info.java

L 2 Set the Default output ‘reate module-info.java file
folder by clicking the Defauit output folder.
browse button Lab01.1_date-client/bin

=/Browse to modules/example.date
« This already exists in our startup folders

Choose the folder for the build cutput

= Lab01.1_date-client

« Ifitdidn't, you'could just type it in, and bin
Eclipse would create it modues
. C||Ck OK sre
¢ You're set — Click Finish J"““’ module-infojava fila
— See notes for screen shot of Default cutput folder:
reSUIting prOjeCt (L&I:C 1.1 _date-client/modules/example.date

Lab 1.1: First Module Project 26

Notes:

¢ Once done, it looks pretty much like a regular Eclipse_ project.
— We've just changed the default source and output folders to follow module conventions.

SE=T| ab01.1_date-cient
Eﬁ src/example.date
é---t‘u com.example.date
[ Main.java
==\ JRE System Library [JavasE<i ]
[a:; modules
L SrC
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Labs: Java Modules and New Features Lab 1.1: First Module Project

Going Modular - Before and After %

Tasks to Perform

¢ We can run our project as a Java 8 classpath-based application
— Right-click Main.java > Run As - Java Application
— Works-as before (in Lab 0.0, when we ran it from the command line)

» Now we'll'write a very simple module descriptor for our project
—~ Right-click on source folder src/example.date > New - File
— Name the file module-info.java and write the descriptor — see notes:

module example.date {
// nothing to export or.require

¥
— Save the file (which compiles it), and now we have errors in the project!
&4 Errors (2 items)
The type java.sql.Datéig not accessibla
The type java.sql.Date is'ngtdccessible
Lab 1.1: First Module Project 27
Notes:

¢ There is an Eclipse wizard for this task, which adds more intelligence to this operation, but we
don't want that at this time — there's a reason...
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Labs: Java Modules and New Features Lab 1.1: First Module Project

Going Modular - Before and After w

+ What's happening here and why?
— Every module implicitly reads platform module java.base
—'Before our code was put in a module, it implicitly read java.se
» This.module gives legacy Java 8 code access to the entire Java SE platform
*Minus the things that were removed in JDK 11, e.g., JAXB
* But now we don't get that for free!

Tasks to Perform

+ SeeJavadoc for each of these platform modules:
- java:base, java.se,and java.sql

java.sal.Date bday = java.sql.Date
ShOW( bday 43 The type java.sgl.Date is not accessible

¢ You'll need to add a requires I quick fx avaiable:
dlrectlve for the J'ava . Sq'l mOdUIe j§va;t1 ME & Add 'requires java.sql to module-info.java

— Before you do, examine the errors in Main.java and note the quick fix

¢ Re-run the application - 'should work now

Lab 1.1: First Module Project 28

Notes:

+ Shouldn't we also do this for the other Lab 0.0 projeet, jaxb-client-8?
— We could, but it's better to wait until we know more about the different types of modules (next).
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